
 
 
 

The Technology Help 
Book 

 
 
 
 

An Online Technology Assistance Handbook 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Department of Physical Therapy 
The University of Tennessee at Chattanooga 

615 McCallie Avenue 
Chattanooga, TN 37403 

423 425-4747 



Page 2 of 14         
6/22/2010 

Table of Contents 
(Control + Click on the desired topic) 

 
• Is online learning for me? ………………...………………………………...………3 
• Do I have the right computer?.........................………………………………...……3 
• Suggested minimum hardware/ software platforms…...………………………...… 3 
• Browser versions………………...…………………………..……………………...4 
• Browser compatibility………………...………………………..…………………...4 
• Help with file sand UTC e-mail on MocsNet………………...…………………….4 
• Registration and Records information………….....………………………………...4 
• How to register online………………...…………………………………….……....4 
• Continuing education………………...……………………………………………..4 
• Information on Continuing Education office for online students…………………..4 
• Technical troubleshooting………………...……………………………………..….5 
• How to change personal information in the UTC system………………...………...5 
• UTC online Blackboard help………………...……………………………………...5 
• Blackboard access description in your document is cumbersome……………….....5 
• Submitting dropbox items………………...………………………………………...6 
• Sending an e-mail within UTC online………………...………………….………....6 
• Discussion board information and use………………...……………………………6 
• Submitting items through assignment feature on Blackboard………………....…...5 
• Looking up grades, accessing instructor comments and feedback on Blackboard…6 
• Links to plug-ins and helper files………………...…………………………………6 
• System recommendations………………...…………………………………………6 
• Browser check and setup for Blackboard………………...…………………………6 
• Accessing grades………………...………………………………..………………...6 
• Help with Word and PowerPoint………………...…………………………………7 
• AMA Style Manual………………...………………..……………………………...8 
• Practice exercises………………...…………………………………………………8 
• Course syllabi………………...…………………………………………………......9 
• Library information………………...……………………………………………...10 
• Acceptable use policy………………...………………………………….…….......12 
• Accommodations and assistance………………...………………………………...12 
• Honor system………………...……………………….……………………………13 
• Plagiarism ………………...…………………………………………………….....13 
• Rules of behavior on the internet ………………...…………………………….....13 



 
This handbook has been developed with the intent of assisting potential students, current 
students and faculty with their technology problems as they participate in online learning.  
Note that this handbook is a continuing work in progress; if you encounter problems or 
issues that are not addressed herein, please contact Dr. Randy Walker (Randy-
Walker@utc.edu) with your questions. 
 
Is Online Learning for me? 
 
If you are considering enrolling in the online transition Doctor of Physical Therapy 
program and you are not confident about your technology skills or where to begin, take a 
look at one or more of the websites listed below.  Online learning is not the same as the 
interactive learning that occurs in a face to face classroom experience.  People learn 
differently.  These self-assessment instruments will allow you to reflect upon your ability 
to learn in an online format. 
 
http://goml.readi.info/ Readiness for Education at a Distance Indicator (READI) from the 
University System of Georgia 
 
http://www.onlinelearning.net/ole/holwselfassess.html?s=024.z0603380m.071i500l31  
An assessment offered by Online Learning.net 
 
http://www.cod.edu/dept/CIL/CIL_Surv.htm  An assessment offered by the Center for 
Independent Learning 
 
http://cdl.senecac.on.ca/Prospective/SelfAssessment  An assessment offered by Seneca 
College 
 
Return to Top 
 
Do I Have the Right Computer? 
 
The University of Tennessee at Chattanooga uses Blackboard as the teaching platform for 
online courses.  The following hardware and software are the minimum requirements to 
effectively participate in online learning at UTC: 
 
Return to Top 
 
Suggested Minimum Hardware/Software Platforms:  
(see http://itd.utc.edu/hardware/hardware.php for more information). 

• Platform: Windows XP or Vista; Macintosh OS X 10.4 or greater (although lower 
systems will often work) 

• Hardware: 64 MB of RAM, 5G of free disk space  
• Software: Microsoft Office including Word and PowerPoint, Adobe Acrobat 

Reader 
• Broadband access (e.g.) DSL or Cable Modem 

mailto:Randy-Walker@utc.edu
mailto:Randy-Walker@utc.edu
http://goml.readi.info/
http://www.onlinelearning.net/ole/holwselfassess.html?s=024.z0603380m.071i500l31
http://www.cod.edu/dept/CIL/CIL_Surv.htm
http://cdl.senecac.on.ca/Prospective/SelfAssessment
http://itd.utc.edu/hardware/hardware.php
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Browser Versions (Pop-ups must be enabled to use Blackboard’s Chat feature):  

• Microsoft Internet Explorer 5.0 or higher OR  
• Netscape Navigator 4.77, 7.0 or higher OR 
• Firefox 1.5 or higher  

 
Firefox 1.5 or higher and Internet Explorer 6 are strongly recommended for UTC's 
version of Blackboard; however, if you are running another browser such as Internet 
Explorer 7, and are more comfortable using it, give it a try with your Blackboard 6 
course. There are some noted problems using Internet Explorer 7 with Blackboard.  See 
http://utconline.utc.edu/online/systemreq.php for more information about browser issues 
and proper configuration.   NOTE:  We strongly recommend using Firefox as there are 
several things that simply “work” better on Firefox.  For a free download of this software 
visit:  http://firefox-mozilla-3.com/.  
 
Return to Top 
 
Browser Compatibility 
 
http://utconline.utc.edu/system_test.php  This website tells you about the software 
available on your computer. 
 
Return to Top 
 
Help with Files and UTC Email on MocsNet: 
http://utconline.utc.edu/online/email.php 
 
Return to Top 
 
Registration & Records Information  
 
How to register online:  
http://www.utc.edu/Administration/Records/RegistrationInstructions.php 
 
Return to Top 
 
Continuing Education  
 
Information on Continuing Education Office for online students:  
http://www.utc.edu/ContinuingEducation/ContinuingEducation/dist/index.php 
 
Return to Top 
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Technical Troubleshooting 

For information about Blackboard and troubleshooting problems visit: 
http://utconline.utc.edu/online/bbtutorials.php   

This site has information on: 
• how to log on 
• locating your user name 
• setting your password 
• changing your password 
• email issues 
• formatting files for Blackboard 
• where to go to get help with technical issues (when to contact your instructor, 

versus Instructional Technology, versus the Student Technical Support Center) 
  
We also strongly recommend that you visit the site dealing with frequently asked 
questions at:  http://utconline.utc.edu/online/faq.php 
 
Return to Top 
 
How can I change my personal information in the UTC computer system? Click on 
MocsNet from the UTC homepage to edit your information.  
 

• Log into MocsNet 
• Click Search 
• Select People 
• Enter your last name and click on Search 
• Click on your last name 
• Click on Edit Information and enter the information you want to add or to change 
• Click on the Save button 

Return to Top 
 

UTC Online (Blackboard) Help 
 
Blackboard (BB) Access description in your document is cumbersome. 
Go to http://www.utc.edu/ and click on the link below the MocsNet link labeled UTC 
Online (also available in the yellow bar from any UTC web page.  Students do NOT have 
to log into MocsNet to get to UTC Online!) 
 
Return to Top 
 
Submitting Drop Box items:   
see  http://utconline.utc.edu/online/blackboardfeatures.php#dropbox 
 
Return to Top 
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Sending e-mail within UTC Online (covers individuals and groups): 
http://utconline.utc.edu/online/blackboardfeatures.php#email  
 
Return to Top 
 
Discussion Board information and use see: 
http://utconline.utc.edu/online/blackboardfeatures.php#discussion  
 
Return to Top 
 
Submitting items through the assignment feature on Blackboard: 
http://utconline.utc.edu/online/blackboardfeatures.php#assignment 
 
Return to Top 
 
Looking up grades on Blackboard and accessing instructor comments and feedback 
(online and within documents): 
http://utconline.utc.edu/online/blackboardfeatures.php#grades  
 
Return to Top 
 
Links to plug-ins and helper files 
See: http://utconline.utc.edu/plug-ins.php 
 
Return to Top 
 
System Recommendations: http://utconline.utc.edu/online/systemreq.php 
 
Return to Top 
 
Browser check and set up for BB:  
http://utconline.utc.edu/browser.php  
http://utconline.utc.edu/system_test.php  
http://utconline.utc.edu/online/systemreq.php 
 
Return to Top 
 
Accessing Grades: 
http://utconline.utc.edu/online/blackboardfeatures.php#grades  
 
Return to Top 
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Help with Word and PowerPoint 
 
http://office.microsoft.com/en-us/training/FX100565001033.aspx  Microsoft’s help for 
Word and PowerPoint 
 
Formatting Documents in Word: 
http://utconline.utc.edu/online/formatdoc2.php 
 
Word Superscript  
Make text or numbers superscript or subscript 
1. Select the text you want to format. 
2. On the Format menu, click Font, and then click the Font tab. 
3. Select the Superscript or Subscript check box. 
 
Creating Word/Charts:  From Word Help for Word 2003 
Create a chart: 
1. On the Insert menu, click Object. 
2. In the Object type box, click Microsoft Graph Chart, and then click OK.  
Graph displays a chart and its associated sample data in a table called a datasheet. To 
replace the sample data, click a cell on the datasheet, and then type the new text or 
numbers. If needed, you can import data from a text file, a Lotus 1-2-3 file, or a 
Microsoft Excel worksheet. You can also copy data from another program.  
For more information about how to work in Microsoft Graph — for example, how to add 
data labels, change the scale of the value axis, or troubleshoot charts — on the Help 
menu, click Graph Help. To save your chart and return to your document, on the Graph 
menu, click Quit & Return. 
Notes    
•  If you close the datasheet, you can reopen it by double-clicking the chart and then 
clicking Datasheet on the View menu. 
•  If you are working in Microsoft Word, you can create a chart from data in a table. To 
do this, create a table in Word that has text labels in the top row and left column, and 
numbers in the other cells. Then, select the entire table and follow the procedure above. 
•  If you are working in Microsoft PowerPoint, you can change your slide layout to one 
that includes placeholders for charts. To change your slide to one of these layouts, click 
Slide Layout on the Format menu, and then select a layout from the Slide Layout dialog 
box that contains a chart placeholder 
 
Adding an Excel Chart to a Word document for 2003 
Insert an Excel chart into a Word document or PowerPoint presentation: 
1. In Microsoft Excel, click the chart you want to copy. 
2. Click Copy. 
3. Switch to your Microsoft Word document or PowerPoint presentation, and click where 
you want the chart to appear. 
4. On the Edit menu, click Paste Special. 
5. In the As box, click Microsoft Excel Chart Object.  
Do one of the following:  
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•  In Word, to use only the current content of the document, click Paste. To use the latest 
content if the original content changes, click Paste Link. Click OK 
•  In PowerPoint, click Insert an Excel chart into a Word document or PowerPoint 
presentation 
1. In Microsoft Excel, click the chart you want to copy. 
2. Click Copy. 
3. Switch to your Microsoft Word document or PowerPoint presentation, and click where 
you want the chart to appear. 
4. On the Edit menu, click Paste Special. 
5. In the As box, click Microsoft Excel Chart Object.  
 
Do one of the following:  
•  In Word, to use only the current content of the document, click Paste. To use the latest 
content if the original content changes, click Paste Link. Click OK 
•  In PowerPoint, click OK 
 
Please note- these directions are for Word 2003.  For other versions, please visit: 
http://office.microsoft.com/en-us/support/?CTT=97 
 
Return to Top 
 
Style Manual 
 
Excerpts from the AMA Manual of Style are available on Blackboard: 
https://bb4.utc.edu/bbcswebdav/courses/CHEPS_transitionalDPT/AMA%20Manual%20
of%20Style%20Chpt2%20AMA%20Manual%20of%20Style%20Chpt%202/AMA%20C
hpt2.pdf  
 (Look for the blue navigation bar on the left in the TDPT organization.) 
 
Return to Top 
 
Practice Exercises 
 
Each of the following tasks must be completed to assure technological competency to 
begin the t-DPT program 
 
 NAME:   

 Type your name above as LastName_FirstName_EBPcourse  
o e.g. Name: Smith_John_EBP 

 You will be asked to name your files for this course in the following manner: 
LastName_FirstName_NameofAssignment. Notice there is an underscore 
between your LastName and FirstName and NameofAssignment. You will be 
told what to name the assignment for each item that is due. 

 Example: 
o Doe_John_EBPcourse  
o Jones_Sally_Critique 
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I. Microsoft WORD  

 In the UTC-DPT program, most papers/documents must be 
completed in Microsoft WORD (Version 2003 or 2007). 

 Open WORD, blank document. Type the phase “Practice for 
[YourName]”  (e.g. Practice for Joe). Then, save the document to 
the hard drive of your computer or to some storage device (e.g. 
thumb drive). Name the file as follows:  
LastName_FirstName_PracticeDocument  

(e.g. Doe_John_Practice ) Note that there is an underscore 
between the words. 

 Open WORD to a blank document. Type “Practice table for 
[YourName].” Then, on the file menu across the top of the page, 
go to Table; Insert; Table. Set the table for 4 columns and 5 rows. 
Then, fill in the table (type into the cells) the words as shown 
below. [Note: you can highlight all of the content of the table and 
make the Font any size you wish. Here, I changed from a 12 point 
font to a 10 point font. 

 
Practice Table for Joe 

Fall 07 Spring 08 Summer 08 Fall 08 
EBP Pharmacology Health Promotion & Wellness Elective 

II 
Professionalism Differential Dx Administration/Leadership Elective 

III 
 Diagnostic 

Imaging 
Clinical Decision Making Elective 

IV 
  Elective I  

 Then, save the document to the hard drive of your computer or to 
some storage device (e.g. thumb drive). Name the file 
LastName_FirstName_Practice (e.g. Doe_John_PracticeTable). 

 
 Note the location of the “Help” menu for Word. You can always 

use this menu if you do not know how to do something. 
 
Return to Top 

Course Syllabi 

The department does not use one particular format for course syllabus; however, all 
syllabi will have contact information for your instructor, textbook and reading 
assignments, a course description, course objectives, evaluation criteria, grading scale, 
and a course schedule. 

Faculty also will use slightly different designs when creating their Blackboard courses; 
however, all faculty will use the Announcement and Syllabus buttons.  

Return to Top 
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Library Information 

 
Lupton Library: Schedule a Face-to-Face (Individual session) session: 
http://www.lib.utc.edu/forms/form-face.php 
 
Lupton Library Services for Distance/Online Students:  
http://www.utc.edu/ContinuingEducation/ContinuingEducation/dist/index.php 
 
Lupton Library finding full-text articles:   
http://www.lib.utc.edu/finding-fulltext.html 
 
Lupton Library: Evaluating Sources: 
http://www.lib.utc.edu/evaluating-information-on-the-web.html 
 
Guide to Library Research: http://www3.lib.utc.edu/glr/index.html 
 
Lupton Library:  Accessing databases from off-campus : 
http://www.lib.utc.edu/connecting-from-off-campus.html 
 
Library Research Assistance: http://www.lib.utc.edu/research-assistance.html 
 
Library How do I? http://www.lib.utc.edu/how-do-i.html 
 
Citation Help: http://www.lib.utc.edu/citing-your-sources.html 
 
Access to Course Reserves: 
1. Faculty can activate the button in all Blackboard courses to link directly to the Course 
reserves page for the Library. 
> Control Panel > Manage Course Menu > Modify across from Library Reserves > check 
the boxes:  Open in a New Window and Available for Student/Participant users.  Click 
Submit. 
 
OR  

http://www.lib.utc.edu/2.  Other option is to tell them to go to  and click on Course 
reserves form the front page. 
 
OR 
3. Provide a link to http://opac.lib.utc.edu/reserves 

 
Library Practice Exercises 
 

• Go to the UTC library website: www.utc.edu ; then in left hand column, click on 
Library; you will be directed to the UTC Lupton Library Website. 
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• On the home page of the UTC Lupton Library, find the “Services,” then Distance 
Education Students. 
On the Distance Education Students page, in the 2nd paragraph, note the bullets 

 Go to the Illiad website and Logon to Illiad using your ITCID and 
password.  

 Fill out and submit the Distance Learner Registration Form.  
 

• Go to the UTC Lupton Library Home Page. On the Main Menu, click on 
Students; then click on Borrowing from Other Libraries and review information 
on this page. 

 
• Go to the UTC Lupton Library Home Page. On the Main Menu, click on 

Students. Then click on Help. Then click on Ask a Librarian. From here, if you 
have a question, you can email a librarian. The response time is typically within 
24 hours.  

 
• Go to the UTC Lupton Library Main page. Under “Help” click on “Finding full 

text articles” and read the page, focusing on how to use the UTC Textlinker. 
 

• Go to the UTC Lupton Library Home Page. Then under Find, click on Articles & 
Databases. Then, under “to find articles on a subject,” click on Nursing & 
Medical. Note the databases related to Nursing and Medical issues (e.g. CINAHL 
with Full Text). 

 
Click on CINAHL with Full Text. In the FIND box enter “therapeutic exercise” 
(without the quotation marks). In the box directly underneath, enter “pain 
perception” (without quotation marks). Then click on search. A list of several 
articles will appear. For more information on an article, click on the article title.  
 
Some of the articles on the topic are available in internet (html) or PDF full text 
format. For the PDF articles, you can click on the PDF Full text (which will open 
the article) and then save the article to your computer or storage device (e.g. 
thumb drive). If the “PDF full text format” symbol does not appear, click on the 
article title, go to the bottom of the page and click on the following options in the 
order below:  
Check UTC TextLinker   
Check UTC catalog holdings   
Request via UTC ILLiad (InterLibrary Loan) 
 
You have already read about UTC Textlinker and realize that the article may be 
available for free online through a UTC or public subscription. If the article is not 
available online, you must request the article through interlibrary loan. In step #2 
above, you signed up for the Iliad Interlibrary Loan system and as a Distance 
Education Student. So, if the article is not available for free on the internet, you 
can request it through interlibrary loan. The article will most often be delivered to 
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you electronically (you will receive a notice through your UTC email account). In 
some cases, the article may have to be mailed to you. 
 

• Now that you have read about the UTC Textlinker, and know how to find the 
CINAHL database, go back to through step described in the section immediately 
above this one and find articles dealing with “therapeutic exercise” and “pain 
perception.” Click on several article titles and the associated UTC Textlinker to 
determine whether the article is available in hard copy in the UTC Lupton Library 
holdings, available on the internet for free through one of the databases for which 
UTC has a site license, or whether the article must be ordered through Interlibrary 
Loan.  

 
• Additional helpful information is available on the UTC Lupton Library website. 

Look around a bit! You may find some very helpful hints. Always remember that 
if you have a question, your helpful Reference Librarian is available to help you. 
You can email, instant message, call or visit in person to get the help you need. 
Do not hesitate to use this valuable resource. 

 
Return to Top 

Acceptable Use Policy  

The University of Tennessee Chattanooga has an Acceptable Use Policy in regards to the 
use of the technology provided by the university. This document may be found at 
http://www.utc.edu/Administration/AcceptableUsePractices/ and it is suggested that each 
online student take time to read the document in its entirety.  The following acts are 
prohibited:  disrupting network access; using technology resources to violate any state or 
federal law; transmitting abusive, threatening, or harassing messages, chain letters, spam, 
or other communications; or unauthorized attempts to scan or gain access to systems, 
accounts, network traffic or information not intended for you. Violations may result in 
termination of access, disciplinary review, expulsion, and possible legal action. 

Return to Top 
 
Accommodations and Assistance 
 
The University of Tennessee at Chattanooga is committed to complying with the 
Americans with Disabilities Act to assure that no qualified individual is by reason of 
disability, excluded from participation in or denied the benefits of any services, 
programs, or activities provided by the University.  The Office for Students with 
Disabilities (OSD) provides reasonable accommodations to persons with disabilities.  
Information on their services is available at:  
http://www.utc.edu/Administration/OfficeForStudentsWithDisabilities/.  
 
Return to Top 
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The Honor System 
 
The Honor System is designed to foster a campus-wide climate of honesty and integrity 
in order to insure that students derive the maximum possible benefit from their work at 
The University of Tennessee at Chattanooga. The student becomes subject to the rules 
and regulations of the Honor Code upon registration. Each student is obligated to exert 
every effort to insure that the Honor Code is upheld by himself/herself and others. 
Violations of the Honor System will be referred to the UTC Honor Court.  For more 
information see:  
http://www.utc.edu/Administration/StudentDevelopment/handbook/academics.pdf . 
 
Return to Top 
 
Plagiarism 
 
The following statement has been adopted by the UTC Faculty Council and is published 
in the Student Handbook. 
 
To plagiarize means to take someone else's words and/or ideas (or patterns of ideas) and 
to present them to the reader as if they are your own. Plagiarism, then, is an act of 
stealing. It is also a stupid act because it doesn't help you learn, and it is a dangerous act 
because you can be severely punished for it.  You should be on guard against plagiarism 
at any time when writing a paper to be turned in. In some papers you will write, you will 
be assigned to use only your own ideas and will probably not have to worry about 
plagiarism. At any time, however, that you read anything in preparation for a paper or 
consciously recall anything that you have read or heard, you must be prepared to provide 
documentation. Generally, when you use someone else's ideas and/or words, you will 
either quote that person directly or you will paraphrase or summarize that person's words.  
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Netiquette: Rules of Behavior on the Internet 

• Identify yourself: 
− Begin email messages with a salutation and end them with your name. 
− Use a signature (a footer with your identifying information) at the end of a message. 
 
• Include a subject line.  Give a descriptive phrase in the subject line of the message 

header that tells the topic of the message (not just “Hi there!”). 
 
• Avoid sarcasm.  People who don’t know you may misinterpret its meaning. 
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• Assume benign intent. People’s true intent doesn’t always come through in written 
messages. Always assume their meaning is benign; request clarification in a friendly 
way. 

 
• Respect others’ privacy.  Do not quote or forward personal email without the 

original author’s permission. 
 
• Acknowledge and return messages promptly. 
 
• Copy with caution.  Don’t copy everyone you know on each message. 
 
• No spam (a.k.a. junk mail).  Don’t contribute to worthless information on the 

Internet by sending or responding to mass postings of chain letters, rumors, etc. 
 
• Be concise.  Keep messages concise—about one screen, as a rule of thumb. 
 
• Use appropriate language:  
 

− Avoid coarse, rough, or rude language. 
− Observe good grammar and spelling. 

 
• Use appropriate emoticons (emotion icons), if desired, to help convey meaning.  

Use “smileys” or punctuation such as :-) that most people will understand to convey 
emotions.  See website list of emoticons at http://netlingo.com/smiley.cfm and 
http://www.robelle.com/smugbook/smiley.html.  

 
• Use appropriate intensifiers, if desired, to help convey meaning: 
 

− Avoid “flaming” (online “screaming”) or typing sentences in all caps. 
− Use asterisks surrounding words to indicate italics used for emphasis (*at last*). 
− Use words in brackets such as (grin) to show a state of mind. 
− Use common acronyms (e.g., LOL for “laugh out loud”). 
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